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Windows XP  
 
Windows XP is an operating system which runs as an interface between the 
computer and you to help you use the PC and allow you to run complex 
applications. 
 
To open up Windows XP, you need to first login with your userid and password. 
 

1. The Desktop 

1.1  Overview 
The Desktop is where you start when you first log in and it refers to the computer 
screen and includes the taskbar across the bottom and icons which are shortcuts 
to run applications.  The Desktop will always be there during the session, behind 
whatever else you do. 
The Desktop is where you start to access any files, folders or applications and so, 
when viewing folder structures, is placed at the top of the hierarchy of places to 
which you might go. 

THE DESKTOP 
 

 
 
Click here for menu                                                  taskbar 

icons for applications 
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1.2  The Taskbar 
The Taskbar appears along the bottom of your screen and includes the Start 
button and clock.  
 

 
When an application is running a button appears on the taskbar.  This has the 
appearance of being pressed in if the application is the active one (i.e. the one 
currently being used).  To switch to another open application, click on its taskbar 
button and the window will open as the active one. 
 
 
Taskbar operations 
 
To display tooltips: 
Hover with the mouse over the button on the taskbar - hovering over an 
application button gives the name of the file that is open in that application. 
 
To display the date 
Hover with the mouse over the time and the date will display in a tooltip. 
 
To minimise all open applications 
Right click on an empty part of the taskbar, then choose Show the Desktop.  All 
the open windows will be minimised to the buttons on the taskbar, so displaying 
the desktop.  The menu option will then change to Show Open Windows, ready 
for restoring them all.  Clicking on an individual button will display the window for 
that one only. 
 
To tile or cascade windows 
Right click on an empty part of the taskbar, and then choose Tile Windows 
Horizontally, Tile Windows Vertically or Cascade Windows 
 
To view the task list 
This is a way of viewing a list of the applications running on the PC and their 
status.  Right click on an empty part of the taskbar, and then choose Task 
Manager.  Under the Applications tab you can see the list.  From here you could 
select an application that was not responding and use the End Task button to 
close it down.  
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Taskbar customisation 

Right click with the mouse on an empty part of the taskbar and choose 
Properties. 
 
Unlocking the taskbar 
If you take the tick off ‘Lock the 
taskbar’, you will then be able to 
drag it elsewhere on the desktop, 
adjust divisions between taskbar 
areas and change its depth. 
 
Auto-hide the taskbar 
If this option is ticked, the taskbar 
will only appear when your mouse 
pointer approaches the bottom of 
the screen. 
 
Ensure the taskbar is visible 
If you have the option ‘Keep the 
taskbar on top of other windows’ 
ticked, then the taskbar will still be 
visible, even when an application 
window is maximised. 
 
Group similar taskbar buttons 
Ticking this option means, that when more than one instance of an application is 
running, the taskbar buttons will either be next to each other, if there is room, or 
will be consolidated onto one button.  Clicking on the one button will list the open 
files. 
 
Displaying the Quick Launch toolbar 
By ticking ‘Show quick launch’, a useful set of buttons appear on the taskbar next 
to the Start button.  Initially there are shortcuts for your web browser, email 
application and a Show the desktop button, which will minimise all the open 
windows.  Further shortcuts can be added here. 
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1.3  The Start Menu 
The Start Menu is where you can begin to do anything – it provides means to run 
any installed application and find any files that are on the computer, as well as 
customise how it is set up. 
 
Start Menu operations 

To display the Start Menu 
A single click on the Start button displays 
the Start menu. 
 
To close the Start Menu 
Click on any empty space on the desktop. 
 
Starting applications from the Start 
Menu 
There is a list of useful shortcuts to 
applications down the left side of the Start 
menu.  There is a dividing line: those 
above the line (the pinned items) are 
constant, but you can add extra ones here 
yourself; those below the line (the most 
frequently used programs) will change to 
reflect the applications you use most 
often. 
A single click on a menu item will run it. 
If a menu item has an arrow beside it, then you can hover over it to display 
further menus. 
Hovering over All Programs with your mouse pointer will display a list of all 
available applications.   
 
 
Start Menu customisation 

Right click with the mouse over the Start button and choose Properties.  
 
Here you could change the 
style of the Start menu to be 
similar to earlier versions of 
Windows. 
Clicking on the Customize 
button brings up your 
customisation options 
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From here you can choose the number of 
frequently used programs that will be 
listed, and you can clear this list.  
 
 
 
 
 
From the Advanced tab, there are many 
other options. 
 
 
 
 
 
 
 
To display a program at the top of the Start Menu 

Right-click the program you want to display as a pinned item on the Start menu.  
This program could be a link on the Start menu, in Windows Explorer, in My 
Computer, or on the desktop.  Then click Pin to Start menu.  
You can remove a program from the pinned items list by right-clicking the 
program and then clicking Remove from This List.  
You can change the order on the pinned items list by dragging a program to a 
new position.  
 
 

1.4  Desktop icons 
The desktop icons are shortcuts to applications or files.  
A double click will run the application 
A single click selects an icon (– if you then press Enter the application will run). 
A right click on an icon brings up a shortcut menu.  From here you can choose to 
rename it, open it, delete it or look at its properties. 
 
Re-aranging icons 
You can move an icon by clicking on it with the mouse and dragging it. 
You can re-arrange icons by right-clicking on an 
empty part of the desktop, and choosing ‘Arrange 
Icons by’, then choose an option.   
Autoarrange will always put the icons back if they 
get dragged out of place. 
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Creating a desktop shortcut 
Right click on the desktop, choose New, then Shortcut.  Click on the Browse 
button to choose the application/file for which you want the shortcut.  After Next 
you can choose the name for it.  Finish will create it.   
Alternatively, you can drag an application on to the desktop from the Start menu 
for instance, or you can right click on an application link, choose Send to, then 
Desktop (create shortcut). 
 

1.5  Desktop settings 
Customisation of the desktop is done by right-clicking on an empty part of the 
desktop and choosing Properties. 

Changing the display style 
Under the Themes tab, from the 
drop down list by the Themes box, 
choosing Windows XP gives you the 
normal XP look.   
(Windows Classic is a style very 
similar to previous versions of 
Windows, such as NT.) 
Then click OK. 
 
Changing the resolution 
If you think that everything on your 
screen is too small or too large then 
you may want to try changing the 
screen resolution.   
Choose the Settings tab, then drag 
the Screen Resolution slider to what you want – perhaps to 800 by 600 pixels.   
Then click OK. 
 
 

2. To Close Down the PC 

To log off and leave the computer running 
From the Start menu, click on Log Off. 
You can choose to either close your programs and log off or leave your programs 
running and log on as a different user. 

To close down the PC 
From the Start menu, click on Shut Down.  
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This will log you off and prepare your computer for powering off.  It will probably 
power off automatically. 
 
 

3. Changing your password 
Press CTRL + ALT + Delete, then choose Change Password and fill in the form. 
 
 

4. Basic Windows Operations 
Everything you do will run in a window.  All windows have common features. 
 
A typical window 
                                                                                     Minimize  Maximize  Close 
  Control box    Application name      Title bar 
 

 

 
 
 
 
 
 
   scroll bar 
 
 

 menu bar 
 
toolbar 
 
 
 
 
 
 
 
 
 
status bar 
 

To move a window 
Click on the title bar and drag it. 

To maximise a window 
Click on the Maximize button at the top right.  The application will then fill the 
screen (except for the taskbar at the bottom). 

To restore a Window 
Click on the Restore button.  When a window is maximized, the Maximize button 
becomes the restore button and will return the window to the size it was before 
being maximized. 
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To minimize a window 
Click on the Minimize button.  The application will shrink down to a button on the 
taskbar.  Clicking on the taskbar button will bring it back. 

To resize a window 
Click on the border and drag to the size required.  Dragging the corner enables 
both sides to be resized at once. 

To close a window 
Click on the X at the top right corner.  The application will be closed down.   

The Control Box 
Clicking this brings up a menu for some of the above operations.  Double clicking 
closes the window. 

Scrolling 
If all the content of the window is not visible there will be a scrollbar(s). Click on 
the arrows at each end of a bar to scroll. 

Moving between open windows 
Alt+Tab 
or click on a taskbar button. 
 
 
See Appendix A for a fuller list of Windows operations for mouse and keyboard  
 
 

5. Drives, Folders and Files 
See ‘Where to save your work’ in Appendix B for information about the different 
drives. 
Files on a computer drive can be saved into folders, which are arranged in a 
hierarchical or tree structure.  You can create your own folders into which you 
can save your files, so as to make them easy to find again.   
You should keep your own files separate from any existing files on your 
computer, as these may be system files that are needed to run the computer. 

My Computer 
This is a collection of the drives accessible to you from your computer, such as 
your floppy drive or CD ROM drive.  It appears in the Start Menu and sits directly 
under ‘The Desktop’ in the hierarchical structure. 
You can also access your personal and shared network drives (h: and s:) from 
My Computer, but not other computers on the network.  
Your local area on the network will be labelled with your login name    e.g. Itnjh 
on ‘User1\Staff\User’ (H)).  The H is not always visible being at the end of the 
label. 

WINDOWS XP - 8 - A USER GUIDE 



My Documents 
When you are logged in to the network on a University PC, My Documents is set 
up to point directly to your H: drive, your home area on the network.  (It would 
otherwise point to an area in your profile on the C: drive.) 
‘My Documents’ appears in the Start Menu and sits directly under ‘The Desktop’ 
in the hierarchical structure.  You will also see links to My Documents throughout 
Windows as you work, so the direct link to H can be useful when you want save 
or find your own files. 

Saving your work 
Within an application, the menu item File, Save As   takes you to a dialogue box.  
From here you will need to choose where to save your work as a file and give the 
file a name.   
This is a typical Save As screen: 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Direct link to 
H drive 

Choose drive here 
where file is to be 
saved 

 
Save in box.  Click on the black arrow to the right of the box and
drive you require (usually H:).  Alternatively to get to H, click on t
Documents button. 
The contents of whatever drive or folder is showing in the Save i
displayed in the space below. 
Double clicking on a folder opens it (putting its name in the Save
displays its contents below.  You can repeat this and so go down
structure until you are displaying the folder where you want to sa
If you need to go back up the structure, use the icon with the up 
right of the Save in box. 
Give the new file a name in the File Name box. 
Click on the Save button.  
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Finding your files 

Within an application, the menu item File, Open takes you to a dialogue box.  
From here you will need to choose where your work was saved.  The Open 
screen is very similar to the Save as screen above and you navigate through the 
file structure in the same way, until you have found the folder where your file is.  
You then select the file and click on the Open button. 
If you cannot find your file then you can use the Windows Search facility. 
 
Search 
This Search facility is accessed by clicking on Search on the Start Menu or by 
clicking on the Search toolbar button within My Computer or My Documents.   
 
A Search Companion pane 
shows down the left of the 
window and you can specify 
various known criteria to assist 
in the search.  For instance 
you may know when it was last 
modified or part of the file 
name.  You can even specify a 
word contained in the 
document.   
You will need to make sure it is 
searching within the 
appropriate drive – you may 
need to change the drive from 
C (the default) to H.  This is 
done after choosing ‘More 
advanced options’. 
 
An Example: 
You might choose Documents.  
You could leave the Name box: 
blank to search for all files and 
folders in a drive or folder or you could type as much of the name as you know, 
using the wildcard * for unknown parts e.g. *.doc would find all Word files, b*.doc 
would find all Word files beginning with b, and *.xls would find all Excel files. 
Advanced options allow you to select the drive to search by clicking on the black 
arrow to the right of the Look in box and choosing a drive 
or type the path to a particular folder in the Look in box in the form h:\courses. 
If you can narrow the search by filling in when it was last modified it will speed up 
the search. 
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You could also include a word from the document to 
help the search. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. File Management 
You may be used to using Windows Explorer from previous versions of Windows, 
and you can continue to use it.  However the screen is very similar with one 
exception to that of the folder windows displayed from My Documents or My 
Computer, which I suggest you may now want to use for your file management 
tasks. 

6.1  Windows Explorer 
You can find Windows Explorer from the Start menu, All Programs, Accessories.  
If you like to use this and find it a bit inaccessible there, you could pin it to the 
Start Menu (see Section 1.3). 
The left pane displays a tree structure of drives and folders:  ‘The Desktop’ at the 
top level and ‘My Computer’ at the next level down.  The drives available to you 
are shown next with the folders on those drives arranged in the structure below 
each. 
A folder is selected with a single click and it appears blue.  The right pane 
displays the contents of the selected folder.  
The path of the currently selected folder appears in the Address box at the top 
left of the screen. 
The only difference between Windows Explorer and the Folders windows 
described next are that Windows Explorer opens with the Folder list option 
already chosen.  If you were to click on the Folders button on the taskbar it would 
then be the same. 
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6.2  Folder windows 
Overview 
Elsewhere, when displaying a folder in a window, such as from My Documents or 
My Computer, there is a Task Pane at the left of the window, which lists links to 
common file and folder management tasks.   
You can select a file or folder, and then click a 
task.  These tasks change according to what you 
have selected, but will probably include renaming, 
copying, moving, and deleting.   
 

 
 
 
 
 
 
 
 
 
 
 

Expanding the Details area will show information 
about the item selected, such as when it was last 
modified. 

 
 
Several folders 
provide links to specialized tasks. 
 
 
 
If you prefer to replace the task pane at the left hand 

side with a folder structure (like in Windows Explorer), so as to make it easier to 
find your way around, click the Folders button on the toolbar (or go to the VIEW 
menu, Explorer Bar and choose Folders).   
 
To put the pane back, click the Folders button again (it is a toggle) or go back into 
the menus and take the tick off. 
 
Panes can be resized by dragging the central border. 
 
You can also choose how you want the files and folders at the right hand side to 
be displayed.  This can be done from the View menu or by clicking on the View 
button on the toolbar.  This will change the view for the current folder only. 
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Folder Options 
Options about the Folder window for customising it are found from the TOOLS 
menu, then Folder Options.  
Some examples: 
File extensions 
If you want to see file extensions (i.e. the .doc at the end of the name for a Word 
file etc.), go to the Folder Options and choose the View tab and it is in the 
Advanced settings list (-no tick for ‘Hide extensions for known file types’). 
Icon types 
If you want to see a list of the different icons with information about them, go to 
Folder Options and the File types tab. 
Changing the view for all folders 
If you want to change the view for all folders, for instance to show Details, then 
you should change the current folder to Details, then go to the TOOLS menu, 
Folder Options, the View tab, then click on the Apply to all Folders button. 
 
 
Navigating 
Whether the Folders list is showing or not, it is the same structure of drives and 
folders that you may want to navigate around. 
The path of the currently selected folder appears in the Address box at the top 
left of the screen. 

Folder structure 
When the folder list is showing, you can view the hierarchical structure of folders:  
‘The Desktop’ at the top level, ‘My Computer’ at the next level down.  The drives 
available to you are shown below My Computer with the folders on those drives 
arranged in a tree structure below each.   
You will be able to see ‘My documents’ at the same level as My Computer for 
convenience, but it is the same as the root (top of) of the H drive.  This is where 
you will most usually be keeping your work, but it is useful to build your own 
structure of folders below this so you can organise your files. 

 
Moving around the structure 
When you see a folder name, either in the right pane or on the Folders list, 
double clicking on it will open it.  The new path will appear in the Address box 
and the contents of the folder are displayed in the right pane.  You can thus step 
down through a hierarchy of folders. 
Toolbar buttons can be used to move back up through the structure, or you can 
double click on a drive or folder name on the Folders list if visible. 
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Using the toolbar buttons 

There are some useful buttons for navigating around your folders.   
There are Back and Forward buttons to revisit places you have been  
 

 
 
and an Up button to move up a level in the folder structure. 
You can also add a file or folder to your Favorites (a menu item) and then you 
can quickly bring it up again by choosing it from your list of Favorites. 
There is a Search button on the toolbar which opens up a Search pane at the left 
of the window, from which you can search for files or folders.  This is similar to 
doing a Search from the Start menu (see Section 5). 
 

Using the Folders list 

Double clicking on a drive or folder in the Folders list, selects the drive or folder 
and displays the contents at the right hand side.  It also expands the tree to show 
any folders at the next level down. 
A single click selects the drive or folder and displays the contents at the right 
hand side, but does not expand the structure. 
You will see a + or – sign by a drive or folder name.  A single click on the sign will 
either expand or collapse the structure, but will not change the file selection.  
Thus the display at the right hand side will not change, as it always shows the 
contents of the selected drive or folder. 
 

Arranging the view of files and folders 

When you are looking at the contents of a folder, you can arrange the contents to 
suit you in various ways. 
As well as choosing how the files and folders display (as icons, showing details 
etc.), you can also arrange them by name, size, type and date modified.  This can 
be done from the View menu, Arrange icons by, and then choosing which you 
want.  
The same arranging can be done also in Details view, by clicking on the 
appropriate heading in the right hand pane.  For instance, clicking on the heading 
Date Modified, will sort the contents in date order.  Clicking on a heading a 
second time will reverse the sort, from earliest first to most recent first, or from A-
Z to Z-A.   
In Details view further details can also be displayed.  From the View menu, go to 
Choose Details, then select from the list.  You could display the number of pages 
or the date each was created. 
The View menu allows you to toggle the toolbars and status bar on and off 
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File and Folder actions 

Many file and folder actions can be done by selecting the file or folder from the 
right hand pane of a folder window, and clicking on the appropriate task at the left 
hand side.  Alternatively you could choose the action from the File menu or from 
the right-click menu.   
In all cases remember you select the file(s) or folder(s) first, then do the action. 

Selecting 

To select a single file 
Click on the file 

To select adjacent files 
Click on the first file then SHIFT + click on the last file. 

To select several non adjacent files  
CTRL+ click on each file. 

To remove any selection 
CTRL+click on a selected file. 

To remove all selections 
Click on any one file. 
 

Seeing the path 
Look in the address box  

 

Deleting 
File menu, then Delete,  
or the DELETE key 
(Can also be done from the Task pane or right-click menu.) 

 

Renaming  
File menu, then Rename 
The name is then selected.  Type the new name and press Enter. 
(Can also be done from the Task pane or right-click menu.) 

 

Viewing properties 
(i.e. date created, size etc) 
File menu, then Properties 
(Can also be done from the right-click menu.) 
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Moving and Copying 

There are a number of alternative ways of doing this. 

using the right-click menu 

Right click with the mouse button over a selection and choose either Cut (for 
moving) or Copy.  Position your mouse pointer in the destination folder, 
right-click and choose Paste.   

using the task pane 

Make a selection, and then choose either Move... or Copy... from the Task 
Pane.  A new window will open showing a folders list and you are asked to 
select a destination folder. 

using keystrokes 

Make your selection, then 
CTRL+X for Cut  (for moving), or 
CTRL+C for Copy  (for copying). 
Position in the destination folder, and 
CTRL+V for Paste  (for putting at the destination) 

using the menu 

Make you selection, then go to  
Edit menu, then Cut (to move) or Copy (to copy) 
Position at the destination, then 
Edit menu, then Paste 

using the mouse 

Not recommended as it is easy to make mistakes.   
You can click on a selection and drag to another folder to move it, or hold 
the CTRL key down at the same time to copy it.   
Alternatively you can click with the right mouse button and drag to the 
destination.  When the mouse button is released choose either Copy Here 
or Move Here from the shortcut menu which then displays. 
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Creating a new folder 

There are a number of alternative ways of doing this. 

Using the right click menu 

Right click with the mouse button over an empty part of the parent folder 
(the one below which you want the new folder).  Choose New, then Folder.  
A new folder appears ready for you to type the name for it and press Enter.  

Using the task pane 

If there are no files or folders in the parent folder selected, then in the Task 
Pane you can choose ‘Make a new folder’.  A new folder appears ready for 
you to type the name for it and press Enter. 

Using the menu 

Select the ‘parent’ folder or drive, go to the File menu, then New, then 
Folder.  A new folder appears ready for you to type the name for it and 
press Enter. 

 
 
Refreshing the screen 

This may be necessary if changes have been made to files/folders and they are 
not showing.   
Go to the View menu, then Refresh. 
 
 
Disk Utilities 

These can be accessed using the right mouse button pointing at the required 
drive. 

Formatting a disk 

This wipes all the data from the disk and so should only be used for floppy 
disks (A: drive). 
Format 

Finding out information about a disk  

such as size and free space. 
Properties, General tab 

Accessing tools for defragmenting a disk  

Properties, Tools tab 
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7. Getting Help 
There are various ways of getting Windows help. 

To search for help on a Windows topic 

From the Start menu, click on Help and Support.   
In the Search box type the topic you want to know about, and click on the Start 
Searching arrow.  Click on a Suggested Topic to view the Help information for it. 
When you view a help screen you can choose to print it.  You can also add it to 
Favorites if you want to be able to access it again quickly. 
Choose the Back button to view earlier help screens. 
The Home Button takes you back to the initial Help and Support screen. 
The initial screen has paths to lots of topics listed on the left-hand side as an 
alternative to searching. 

To get help in dialogue boxes 

Click on ? at the top right of a dialogue box and then click on the label you need 
help on. 
Click away from the help text to remove it from the screen 

Remote Assistance 

It is possible to get assistance remotely from the Help Desk.  This means that 
when you have a problem, the Help Desk could in effect have a look at your 
Desktop and take control if necessary.  This would only be done with your 
knowledge and permission. 

To view System Information 

In the My Computer window, under System Tasks, choose View System 
Information.  From the screen that comes up you can, for instance, see how 
much memory your PC has. 
 
 

8. Customising Windows 
Many of the settings for customising how things work are accessed from the 
Control Panel.  From the Start Menu, click on Control Panel.   

The functions are organised by category to make it easier to find what you want, 
though you can ‘Switch to Classic View’ to see the icons for the individual 
programs. 
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You may not be allowed to make some changes. 

To change mouse settings 

Choose Printers and other hardware, and then Mouse.  The screens you will then 
see for customising will vary according to what mouse you have installed, but will 
give options for swapping the mouse buttons (to assist left handed users), or 
changing the speed required for double clicking. 

To install a printer 

Choose Printers and other hardware, and then Add a Printer.  Then follow 
through the steps of the wizard. 

Changing the default printer 

From the Start menu, choose Printers and Faxes. 

Right click on a printer name and choose ‘Set as Default Printer’. 
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9. Printing 
In most applications, going to the File menu, then Print will bring up a Print 
dialogue box.  Choosing print will print to the default printer, unless you first 
choose a different printer. 

To look at a print queue 

From the Start menu, choose Printers and Faxes, and then double click on the 
printer name. 
This will show jobs waiting to be printed on that printer and their status. 

To cancel a print job 

If a print job is sitting in the printer queue, click on the job with the right mouse 
button.  Choose Cancel. 
(You can only cancel your own jobs) 
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APPENDIX A:  BASIC WINDOWS XP OPERATIONS  
with keystrokes 

OPERATION MOUSE ACTIONS ALTERNATIVE KEY 
STROKES 

Start Menu   

Display menu Click  on Start  Ctrl + Esc 

Close menu Click on an empty 
desktop space, anywhere 
away from the Start Menu

Esc 

General Windows XP   

Open Control Box 
(current window) 

Click on control box (on 
left of title bar) 

Alt + Spacebar 

Close Current Window Double click on control 
box or click on Close 
button  

Alt + F4 

Display shortcut pop-up 
menu for the selected 
item 

Right click on selected 
item 

Shift + F10  

Switch to window last 
used 

 Alt + Tab  

Minimise all open 
windows 

Right click on an empty 
space on the taskbar and 
choose Show the 
Desktop 

Alt + M (when clicked on 
an empty part of taskbar) 

Bypass Autoplay when 
inserting a compact disk 

  Shift (while inserting CD 
ROM) 

Move window Click on title bar and drag   

Resize window Click on border and drag   

Minimize Click on min button  Alt + Spacebar, N 

Maximize Click on max button  Alt + Spacebar, X 

Restore Click on restore button Alt + Spacebar, R 
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Application Icons   

Select an application Click on the application 
icon 

Arrow keys 

Run an application Double click on the 
application icon 

Enter (if the icon is 
selected) 

Quit an application Double click on the control-
box or click on the X at the 
top right of the window 

Alt + F4  

List applications 
running 

Look at the buttons on the 
Taskbar 

Alt + Tab, keep Alt key 
down & repeatedly press 
Tab, moves from icon to 
icon 

Switch applications Click on an application 
button on the Taskbar 

Alt + Tab, and release 
when required application 
is listed. 
Or, when focus is on the 
Taskbar, use the arrow keys and 
press Enter when the required 
application button is highlighted.  
(To get focus on the Taskbar, 
Ctrl + Esc, then Esc) 

Menus   

Select a menu item / 
subitem 

Click on the item / subitem Alt + underlined letter 
/underlined letter        
Or, press Alt to select first menu, 
left and right arrow keys to 
change menus, up and down 
arrows to change options and 
enter to make the selection. 

Cancel selection Click anywhere off the 
Menu bar 

Esc 

My Computer & Explorer   

Rename a selected item Click File, Rename F2 

Refresh Dialogue box   F5 

Open the Search  
dialogue box 

Click the Search button F3 
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Appendix B:   Where to save computer files. 
 
The computer drive options are: 
 
Computer’s own hard disk 
This is a disk inside each computer that is known as the C: drive.  This is where 
you can save work on home computers, but it is not advisable at The Robert 
Gordon University.  If there is a serious problem with your PC then this hard disk 
could be wiped in the recovery process and you would lose your work. 
 
Floppy disk 
This is a small removable disk that is useful for backups or for transferring files 
between work and home.  The computer knows the floppy disk drive as the  
A: drive.  You should not work directly from these disks as not only will it be very 
slow, but they are also not reliable enough. 
 
Network Drives 
Every computer user at the University is given an account to use the network. 
You are allocated a personal area of storage space on the network known as the 
H: drive (H for home).  This is where your work should be stored.  This storage is 
reliable, secure and is backed up every night. 
 
If you are sharing files with colleagues then you may need to use the shared 
drive on the network known as the S: drive. 
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